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Preface
SLEU091B–October 2007–Revised June 2009

Read This First

About This Manual
This manual describes the operation of the TAS3204EVM evaluation module from Texas Instruments.

How to Use This Manual
This document contains the following chapters:

Chapter 1 – Overview
Chapter 2 – Quick Setup Guide
Chapter 3 – PWM Audio Amplifier Setup
Chapter 4 – TAS3204 Slave Mode

Information about Cautions and Warnings
This manual may contain cautions and warnings.

CAUTION
This is an example of a caution statement.

A caution statement describes a situation that could potentially damage your
software or equipment.

WARNING
This is an example of a warning statement.
A warning statement describes a situation that could potentially
cause harm to you.

The information in a caution or a warning is provided for your protection. Please read each caution and
warning carefully.

PurePath Studio, PurePath Digital are trademarks of Texas Instruments.
All other trademarks are the property of their respective owners.
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Related Documentation From Texas Instruments www.ti.com

Related Documentation From Texas Instruments
The following table lists data manuals that have detailed descriptions of the integrated circuits used in the
design of the TAS3204EVM. The data manuals can be obtained from http://www.ti.com.

Related Documentation From Texas Instruments
Part Number Literature Number

TAS3204 SLES197
TAS5086 SLES131
TAS5132 SLES190
DIR9001 SLES198
DIT4192 SBOS229
SRC4190 SBFS023

TAS5132DDV2EVM SLLU097

Additional Documentation
• PurePath Studio Graphical Development Environment
• General TAS3204 application reports

Important Software Updates
The TAS3204EVM is shipped with the latest version of PurePath Studio™ GDE at the time of the initial
evaluation module release. Before starting any new design, verify that you are using the latest version of
PurePath Studio GDE available by requesting access to the Texas Instruments Mixed Signal Audio and
Video Extranet. Once access is granted, any new build of the software can be downloaded via an existing
internet connection.

TAS5132 PWM Audio Power Amplifier
The TAS3204 is equipped with a header that interfaces with the TAS5132DDV2EVM. If an audio power
amplifier is needed, the TAS5132DDV2EVM can be purchased in addition to the TAS3204EVM from the
TI eStore.

Trademarks
PurePath Studio, PurePath Digital are trademarks of Texas Instruments.

All other trademarks are the property of their respective owners.
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Chapter 1
SLEU091B–October 2007–Revised June 2009

Overview

The TAS3204EVM PurePath Digital™ customer evaluation module enables the customers to examine the
TAS3204 capabilities as detailed in the TAS3204 data sheet (SLES197).

The TAS3204PAG is a high-performance digital audio processor. It is an audio system-on-chip (SOC)
designed for mini/micro systems, multimedia speakers, and MP3 player docking systems. It includes
analog interface functions and four channels of serial digital audio. The TAS3204 has a programmable
audio digital signal processor (DSP) that preserves high-quality audio by using a 48-bit data path, 28-bit
coefficients, and a single-cycle 28 × 48-bit multiplier.

Topic .................................................................................................. Page

1.1 TAS3204EVM Features ................................................................ 8
1.2 PCB Block Diagram................................................................... 10
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1.1 TAS3204EVM Features
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TAS3204EVM Features www.ti.com

• Three stereo analog channel inputs
• Two stereo analog channel outputs
• Digital input options: SPDIF or user’s I2S input [e.g., Audio Precision (AP)]
• Digital output options: SPDIF, user’s I2S output (e.g., AP)
• USB interface for I2C control via graphical design environment

Figure 1-1. TAS3204EVM PCB Mapping
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www.ti.com TAS3204EVM Features

Figure 1-2. TAS3204EVM

Figure 1-3. TAS3204EVM Interface with TAS5132DDV2EVM
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1.2 PCB Block Diagram
PCB Block Diagram www.ti.com

Figure 1-4. TAS3204EVM Block Diagram
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Chapter 2
SLEU091B–October 2007–Revised June 2009

Quick Setup Guide

This chapter describes the power supplies and system interfaces of the TAS3204EVM. The chapter
provides information regarding handling and unpacking, absolute operating conditions, and a description
of the factory default switch and jumper configuration.

This chapter provides a step-by-step guide to configuring the TAS3204EVM for device evaluation.

Topic .................................................................................................. Page

2.1 Electrostatic Discharge Warning................................................. 12
2.2 Unpacking the EVM ................................................................... 12
2.3 Power Supply Setup .................................................................. 12
2.4 Graphical Development Environment (GDE) Software Installation... 13
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2.1 Electrostatic Discharge Warning

2.2 Unpacking the EVM

2.3 Power Supply Setup

Electrostatic Discharge Warning www.ti.com

Many of the components on the TAS3204EVM are susceptible to damage by electrostatic discharge
(ESD). Customers are advised to observe proper ESD handling precautions when unpacking and handling
the EVM, including the use of a grounded wrist strap at an approved ESD workstation.

CAUTION
Failure to observe ESD handling procedures may result in damage to EVM
components.

Upon opening the TAS3204EVM package, please check to make sure that the following items are
included:
• One TAS3204EVM board using one TAS3204PAG
• Two 9-V AC-to-DC adapters
• One CD containing PurePath Studio Graphical Development Environment, full device data manual, and

design and board files
• One USB Type A to Type B cable

If any of these items is missing, please contact the Texas Instruments Product Information Center nearest
you to inquire about a replacement.

Plug in the ac-dc adapters to PJ1 and PJ2. These adapters provide +9 VDC and –9 VDC to the
TAS3204EVM and can be plugged in any order. The on-board circuit automatically configures the
voltages, i.e., polarity is correct. Please see note for using lab supplies in place of ac-dc adapters.

Note: If using lab supplies to power the TAS3204EVM, ensure that the polarity is correct and that
the grounds on the two supplies are isolated:

J2 – Pin 1: 9 VDC, Pin 2: Ground
J8 – Pin 1: Ground, Pin 2: 9 VDC

Table 2-1. Recommended Supply Voltages
VOLTAGE CURRENTDESCRIPTION CONNECTIONLIMITATIONS REQUIREMENT

System/analog power supply +9 V 1 A PJ1 or J2 (+ pin 1)
Analog power supply –9 V 0.5 A PJ2 or J8 (– pin 1)

CAUTION
Applying voltages above the limitations given in Table 2-1 may cause
permanent damage to the hardware.

Quick Setup Guide12 SLEU091B–October 2007–Revised June 2009
Submit Documentation Feedback

http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLEU091B


2.4 Graphical Development Environment (GDE) Software Installation
www.ti.com Graphical Development Environment (GDE) Software Installation

The GDE is used to program the TAS3204. To install the GDE, run SETUP.EXE from the provided
CD ROM.
1. After installation, connect the ac-dc power adapters and connect the USB cable to the PC. The PC

must be running Windows® XP®.
2. Start the GDE program from the Windows Start menu. Launching the GDE requires a few seconds.
3. Ensure that the jumpers are set to the defaults shown in Table 2-2.

Table 2-2. Default Jumper Settings
JUMPER POSITION COMMENTSDESIGNATOR

JP1 Out Sets the MCLK to 512Fs out of SPDIF receiver
JP2 In Selects SPDIF clocks
JP3 In Selects SPDIF data
JP4 SDOUT1 Selects SDOUT1 data from TAS3204
JP5 MASTER I2S master mode
JP6 In Disables the MCLK multiplier (2×)
JP7 1x Selects MCLK straight from SPDIF receiver
JP8 In Connect reset line to the TAS3204
MCLKI In Sets MCLK input to ground
SCLKI In Sets SCLK input to ground
LRCLKI In Sets LRCLK input to ground
SDINA In Sets SDINA input to ground
SDINB In Sets SDINB input to ground
GPIO1 Out Sets GPIO1 pin to logic high
GPIO2 Out Sets GPIO2 pin to logic high
MCLKO Out Sets MCLK out signal open
SCLKO Out Sets SCLK out signal open
LRCLKO Out Sets LRCLK out signal open
DATA1 Out Sets SDOUT1 signal open
DATA2 Out Sets SDOUT2 signal open
SRC Select SW SRC Data Selects data from sample rate converter
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Graphical Development Environment (GDE) Software Installation www.ti.com

4. From the File menu, load the process flow file TAS3204.pfw (see Figure 2-1). The file is located on the
CD ROM.
This file contains basic settings for a default setup of the EVM with TAS3204 as an I2S clock master.

Figure 2-1. GDE Window – Load Process Flow

5. From the Tools menu, select the I2C Command tool. In the Execute I2C Command File window,
browse to the file 3204_init_master.cfg. Verify that 'Execute on Reset' Box is checked, then click OK
(see Figure 2-2).

Figure 2-2. Execute I2C Command

6. From the Build menu, select Run.
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Chapter 3
SLEU091B–October 2007–Revised June 2009

PWM Audio Amplifier Setup

This chapter describes the setup for the TAS5132DDV2EVM when interfaced to the TAS3204EVM.

Note: The TAS5231DDV2EVM is not part of the TAS3204EVM Kit. If a PWM Audio Amplifier is
needed, the TAS5132DDV2DVM may be purchased from Texas Instruments. Details about
purchasing this device are outlined in the Read Me First section of this document.

Topic .................................................................................................. Page

3.1 TAS5086 Graphical User Interface (GUI) ...................................... 16

SLEU091B–October 2007–Revised June 2009 PWM Audio Amplifier Setup 15
Submit Documentation Feedback

http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLEU091B


3.1 TAS5086 Graphical User Interface (GUI)

TAS5086 Graphical User Interface (GUI) www.ti.com

The CD ROM contains the TAS5086 GUI. If you have not installed the TAS5086 GUI, run SETUP.EXE
from the CD. After setup is complete, restart the computer. After the restart, run the TAS3204 portion as
shown in Chapter 2.
1. Connect the TAS5132DDV2EVM to the TAS3204EVM (see Figure 3-1).

Figure 3-1. TAS3204EVM and TAS5132DDV2EVM

2. Remove the jumper from JP8 to preserve TAS3204 I2C register settings.
3. Connect music input from either the analog input or the SPDIF input.
4. Attach speakers to J3, J4, J5, and J6 per the labels on the TAS5132DDV2EVM (i.e., the left speaker

connects to J3(+) and J4(–), and the right speaker connects to J5(+) and J6(–).
5. Start the TAS5086 GUI from the Windows Start menu (see Figure 3-2).
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www.ti.com TAS5086 Graphical User Interface (GUI)

Figure 3-2. TAS5086 GUI

6. From the File menu, load the TAS5086FieldTrim.cfg configuration file. This file trims the internal
oscillator to a 48-kHz sampling rate.

7. From GUI screen, click on MUXES button, and verify that the blue dots appear as in Figure 3-2.
8. On the TAS3204EVM, press the MUTE button to unmute the sound output (the MUTE LED is

extinguished).

The music should be audible at the speakers.
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Chapter 4
SLEU091B–October 2007–Revised June 2009

TAS3204 Slave Mode

This chapter describes how to setup the TAS3204 to operate as an I2S slave.

Note: Audio performance in slave mode depends on the quality of the I2S clocks. It is
recommended that the clocks be buffered before TAS3204. The lowest sampling frequency
for acceptable audio performance is 44.1 kHz.

Topic .................................................................................................. Page

4.1 TAS3204 Setup ........................................................................ 20
4.2 TAS5086 Setup (If Applicable) .................................................... 20
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4.1 TAS3204 Setup

4.2 TAS5086 Setup (If Applicable)

TAS3204 Setup www.ti.com

1. If any jumpers were moved, return them to the default settings shown in Table 2-2.
2. See Section 2.4 for instructions on running the GDE.
3. Set JP5 to SLAVE.
4. On the Tools menu, select the I2C Command tool. In the Execute I2C Command File window, browse

to the file 3204_init_slave.cfg. Select the Execute on reset option and click Execute (see Figure 2-2).

When operating as an I2S clock slave, the TAS3204 outputs audio according to the software configuration
if the I2S clocks are correctly supplied externally to the device.

See Section 3.1 for the TAS5086 setup instructions.
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EVALUATION BOARD/KIT IMPORTANT NOTICE
Texas Instruments (TI) provides the enclosed product(s) under the following conditions:
This evaluation board/kit is intended for use for ENGINEERING DEVELOPMENT, DEMONSTRATION, OR EVALUATION PURPOSES
ONLY and is not considered by TI to be a finished end-product fit for general consumer use. Persons handling the product(s) must have
electronics training and observe good engineering practice standards. As such, the goods being provided are not intended to be complete
in terms of required design-, marketing-, and/or manufacturing-related protective considerations, including product safety and environmental
measures typically found in end products that incorporate such semiconductor components or circuit boards. This evaluation board/kit does
not fall within the scope of the European Union directives regarding electromagnetic compatibility, restricted substances (RoHS), recycling
(WEEE), FCC, CE or UL, and therefore may not meet the technical requirements of these directives or other related directives.
Should this evaluation board/kit not meet the specifications indicated in the User’s Guide, the board/kit may be returned within 30 days from
the date of delivery for a full refund. THE FOREGOING WARRANTY IS THE EXCLUSIVE WARRANTY MADE BY SELLER TO BUYER
AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED, OR STATUTORY, INCLUDING ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE.
The user assumes all responsibility and liability for proper and safe handling of the goods. Further, the user indemnifies TI from all claims
arising from the handling or use of the goods. Due to the open construction of the product, it is the user’s responsibility to take any and all
appropriate precautions with regard to electrostatic discharge.
EXCEPT TO THE EXTENT OF THE INDEMNITY SET FORTH ABOVE, NEITHER PARTY SHALL BE LIABLE TO THE OTHER FOR ANY
INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES.
TI currently deals with a variety of customers for products, and therefore our arrangement with the user is not exclusive.
TI assumes no liability for applications assistance, customer product design, software performance, or infringement of patents or
services described herein.
Please read the User’s Guide and, specifically, the Warnings and Restrictions notice in the User’s Guide prior to handling the product. This
notice contains important safety information about temperatures and voltages. For additional information on TI’s environmental and/or
safety programs, please contact the TI application engineer or visit www.ti.com/esh.
No license is granted under any patent right or other intellectual property right of TI covering or relating to any machine, process, or
combination in which such TI products or services might be or are used.

FCC Warning
This evaluation board/kit is intended for use for ENGINEERING DEVELOPMENT, DEMONSTRATION, OR EVALUATION PURPOSES
ONLY and is not considered by TI to be a finished end-product fit for general consumer use. It generates, uses, and can radiate radio
frequency energy and has not been tested for compliance with the limits of computing devices pursuant to part 15 of FCC rules, which are
designed to provide reasonable protection against radio frequency interference. Operation of this equipment in other environments may
cause interference with radio communications, in which case the user at his own expense will be required to take whatever measures may
be required to correct this interference.

EVM WARNINGS AND RESTRICTIONS
It is important to operate this EVM within the input output voltage ranges as described in this user's guide and the TAS3204 data sheet.
Exceeding the specified input range may cause unexpected operation and/or irreversible damage to the EVM. If there are questions
concerning the input range, please contact a TI field representative prior to connecting the input power.
Applying loads outside of the specified output range may result in unintended operation and/or possible permanent damage to the EVM.
Please consult the EVM User's Guide prior to connecting any load to the EVM output. If there is uncertainty as to the load specification,
please contact a TI field representative.
During normal operation, some circuit components may have case temperatures greater than 75°C. The EVM is designed to operate
properly with certain components above 75°C as long as the input and output ranges are maintained. These components include but are
not limited to linear regulators, switching transistors, pass transistors, and current sense resistors. These types of devices can be identified
using the EVM schematic located in the EVM User's Guide. When placing measurement probes near these devices during operation,
please be aware that these devices may be very warm to the touch.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright 2007, Texas Instruments Incorporated

http://www.ti.com/esh


IMPORTANT NOTICE
Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications, enhancements, improvements,
and other changes to its products and services at any time and to discontinue any product or service without notice. Customers should
obtain the latest relevant information before placing orders and should verify that such information is current and complete. All products are
sold subject to TI’s terms and conditions of sale supplied at the time of order acknowledgment.
TI warrants performance of its hardware products to the specifications applicable at the time of sale in accordance with TI’s standard
warranty. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where
mandated by government requirements, testing of all parameters of each product is not necessarily performed.
TI assumes no liability for applications assistance or customer product design. Customers are responsible for their products and
applications using TI components. To minimize the risks associated with customer products and applications, customers should provide
adequate design and operating safeguards.
TI does not warrant or represent that any license, either express or implied, is granted under any TI patent right, copyright, mask work right,
or other TI intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information
published by TI regarding third-party products or services does not constitute a license from TI to use such products or services or a
warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual
property of the third party, or a license from TI under the patents or other intellectual property of TI.
Reproduction of TI information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied
by all associated warranties, conditions, limitations, and notices. Reproduction of this information with alteration is an unfair and deceptive
business practice. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional
restrictions.
Resale of TI products or services with statements different from or beyond the parameters stated by TI for that product or service voids all
express and any implied warranties for the associated TI product or service and is an unfair and deceptive business practice. TI is not
responsible or liable for any such statements.
TI products are not authorized for use in safety-critical applications (such as life support) where a failure of the TI product would reasonably
be expected to cause severe personal injury or death, unless officers of the parties have executed an agreement specifically governing
such use. Buyers represent that they have all necessary expertise in the safety and regulatory ramifications of their applications, and
acknowledge and agree that they are solely responsible for all legal, regulatory and safety-related requirements concerning their products
and any use of TI products in such safety-critical applications, notwithstanding any applications-related information or support that may be
provided by TI. Further, Buyers must fully indemnify TI and its representatives against any damages arising out of the use of TI products in
such safety-critical applications.
TI products are neither designed nor intended for use in military/aerospace applications or environments unless the TI products are
specifically designated by TI as military-grade or "enhanced plastic." Only products designated by TI as military-grade meet military
specifications. Buyers acknowledge and agree that any such use of TI products which TI has not designated as military-grade is solely at
the Buyer's risk, and that they are solely responsible for compliance with all legal and regulatory requirements in connection with such use.
TI products are neither designed nor intended for use in automotive applications or environments unless the specific TI products are
designated by TI as compliant with ISO/TS 16949 requirements. Buyers acknowledge and agree that, if they use any non-designated
products in automotive applications, TI will not be responsible for any failure to meet such requirements.
Following are URLs where you can obtain information on other Texas Instruments products and application solutions:
Products Applications
Amplifiers amplifier.ti.com Audio www.ti.com/audio
Data Converters dataconverter.ti.com Automotive www.ti.com/automotive
DLP® Products www.dlp.com Broadband www.ti.com/broadband
DSP dsp.ti.com Digital Control www.ti.com/digitalcontrol
Clocks and Timers www.ti.com/clocks Medical www.ti.com/medical
Interface interface.ti.com Military www.ti.com/military
Logic logic.ti.com Optical Networking www.ti.com/opticalnetwork
Power Mgmt power.ti.com Security www.ti.com/security
Microcontrollers microcontroller.ti.com Telephony www.ti.com/telephony
RFID www.ti-rfid.com Video & Imaging www.ti.com/video
RF/IF and ZigBee® Solutions www.ti.com/lprf Wireless www.ti.com/wireless

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2009, Texas Instruments Incorporated
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